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Chapter 18 

Windows Accessories Menu—Notepad, WordPad, and Calculator 

Notepad is a very basic word processor that lets you create a file that is just text 

(ASCII).  Simple notes, lists, or computer programs can be written, printed and save 

with Notepad.   

WordPad is a word processor that allows you to add bold, italics, underline, and 

different fonts to your document.  Double spacing, centering, and right or left aligning 

are all possible with WordPad.  It allows you to insert pictures and “Paint” files.  You can 

save your file in Rich Text Format (RTF) so that the bold, italics, underline, and font is 

carried over to word processors such as Microsoft Word.  There is not a spell checker in 

WordPad.  A spell checker can be downloaded from the internet for this program. 

Calculator is a program that allows you to use either a basic calculator or a Standard or 

Scientific mode in Windows XP, or Standard, Scientific, Programmer or Statistics in 

Windows 7. 

Windows XP and Windows 7 both offer three programs in the Windows Accessories 

menu.  As we learned in an earlier chapter, we can get to the Windows Accessories 

menu by tapping the Windows (Start) Key one time.  We then tap the letter “p” until we 

hear or see the “Programs” menu item.  We tap the Enter Key one time to open this 

menu and display the sub menu items.  We tap the letter “a” until we hear or see 

“Accessories,” and then tap either the Enter Key one time, or the right arrow key one 

time to open the “Accessories” sub menu.  When we reach this point we can down 

arrow until we hear or see “Notepad, WordPad, or Calculator,” and then tap the Enter 

Key one time to open that program. 

Notepad and WordPad are both word processors that allow you to type a document, 

save it, print it, or email it.  Neither has a spell checker built in, nor are they developed in 

any way to the level of programs such as Microsoft Word, WordPerfect, or other 

commercial level programs.   

Notepad saves as ASCII text.  This is pure text that has no frills.  You cannot make text 

bold, underlined, or italicized in Notepad.  What Notepad is good for is the saving of a 

text document that you do not want any other types of symbols included.  For example, 



when you save a Word document, the text is saved, along with whatever codes that 

Word used.  This makes it difficult to open in other word processors, and the view of the 

document is rarely the same between the word processors.  If you want the text only, 

Notepad is the word processor to use.  Also, Notepad is the only word processor that 

Windows Narrator will read aloud.  It is the program you have to use to have Narrator 

read back what you typed, or what you have copied into it from the internet or another 

word processor.  If you go on to learn to write computer programs or scripts, it is very 

likely that you will use Notepad to do a lot of your work. 

WordPad saves as text or Rich Text format (RTF).  You are able to bold, italicize and 

underline in RTF format.  You can change the font and the font size when you use RTF.  

You can insert pictures or clipart into WordPad documents.  At this time there is not a 

spell checker built into WordPad.  There are programs for WordPad spell checking that 

you can download from the internet.   

The Calculator program, especially the one in Windows 7, is a nice tool that gives you 

instant access to computing items such as math problems, a grocery bill, utility bills, or 

even figuring percentages and sales taxes.  It is good for fundamental, everyday math.  

If you are an advanced math user, there is the Microsoft Excel program, and many 

commercial level programs. 

  



Notepad 

While you can open Notepad from the Windows Accessories menu, there are two other 

ways to open this program.  One is fast, and the other is efficient.   To quickly open 

Notepad in either Windows XP or Windows 7, press and hold down the Windows (Start) 

Key and tap the letter “r” one time.  Release these keys.  This will bring up the Windows 

“Command Line,” or “Run” box.  Type “notepad” (without the quotes).  Tap the Enter 

Key one time and Notepad will immediately open. 

 

If you choose to open Notepad from either the Accessories menu or from the Windows 

command line, you will need to use the “Save As” dialogue box to tell the computer 

where you want your file saved.  If you do not tell the computer where to save your file it 

will, by default, be saved in the “Documents” folder.  While this is fine if you only have a 

few files, imagine having several hundred files to look through when you want to reopen 

the file you just created.   

  



The most efficient way to create a Notepad file, in terms of organization, is to use the 

Windows File Explorer.  Press and hold down the Windows (Start) Key and tap the letter 

“e” one time.  Release these keys.  If you are in “Tree View,” tap the letter “l” until you 

hear or see “Local Drive C.”  If you are using a USB memory stick, you can go to it by 

either using the up or down arrow key, or by tapping the first letter of the name you gave 

it.  When you reach the local (hard drive), or your memory stick, tap the right arrow key 

to open it, and then down arrow to the folder you want to create a Notepad file in.  Tap 

the Enter Key one time.  Tab one time to go into the “List View.”  Tap the Applications 

Key one time.  Tap the letter “w” one time.  Right arrow one time, and then down arrow 

or tap the letter “t” until you hear or see the “Text Document” menu item.  If you are 

more comfortable using the File menu, press Alt f, release these keys, tap the letter “w,” 

and then down arrow to or tap the letter “t” until you hear or see the “Text Document” 

menu item. 

 

  



Tap the enter key one time and you will be placed in a file name edit box.  Type the 

name you want to give the Notepad document. 

 

  



Tap the Enter Key one time and the file will be created.  Notepad will not be open at this 

point.  The important thing is that you have created this file in a folder that you 

preselected.  This gives you the ability to organize files without having to work through 

the “Save As” dialogue box.   

 

  



You have just created a Notepad file using Windows File Explorer.  You are directly on 

this file.  Tap the Enter (Start) Key one time and the file will open in Notepad. 

 

Type a sentence in Notepad.  Now, you want to save your file.  You do not have to go to 

the “File” menu to do a “Save as,” or “Save.”  Press and hold down the Control Key and 

tap the letter “s” one time.  Your file with the sentence is saved, and it is still in the folder 

on the drive where you created it.  To leave Notepad press and hold down the Alt Key 

and tap the F4 Key one time.  The program will close and you will be back in the folder 

where you created the file.   

  



If you type text into your new Notepad file and forget to save before pressing the Alt F4 

key combination, a box will come up with three buttons.  These buttons are “Save, Don’t 

Save, and Cancel.”  You are placed on the “Save” button.  If you tap the spacebar one 

time the file will be saved and closed.  If you do not want to save the text you just typed, 

tap the right arrow key one time to go to the “Don’t Save” button, and then tap the 

spacebar one time to close the file without saving.  If you want to return to the document 

to type more text, right arrow to the “Cancel” button and tap the spacebar one time—

you can also tap the Escape Key one time to cancel and return to the open document. 

 

  



Saving a Notepad File in Windows XP Using the “Save As” Dialogue Box 

Let’s say you are using Windows XP and have started Notepad from either the 

Accessories menu or the Windows Key “r” command line.  Unless you want your file to 

be saved in “Documents or My Documents,” you are going to need to understand how 

to use the “Save As” dialogue box to save the file where you want it.  In both Windows 

XP and Windows 7 you can access the “Save As” dialogue box in two ways.  The first 

way naturally happens when you have opened Notepad from the “Accessories” or 

command line, typed, and then want to save.  Press and hold down the Control Key and 

tap the letter “s.”  Because your file has never been saved and does not have a name or 

place, the “Save As” dialogue box will appear.  After you do the first save using the 

“Save As” dialogue box, Control “s” will work without opening the “Save As” dialogue 

box for the file you have created. 

 

  



You can also access the “Save As” dialogue box from the File menu.  Press and hold 

down the Alt Key and tap the letter “f.”  Down arrow to or tap the letter “a" to go to the 

“Save As” menu item.  If you tap the letter “a” the “Save As” dialogue box will 

immediately open.  If you down arrow to “Save As,” you will need to tap the Enter Key 

one time to open the “Save As” dialogue box. 

 

  



When the “Save As” dialogue box first opens you will be placed in the “File name” edit 

box (form field).  Type the name you want to give the document.  Do not press Enter at 

this point.  Now, you have a choice of tapping the Tab Key until you arrive at the “Save 

in” combo box, or you can press and hold down the Alt Key and tap the letter “i” one 

time.  Release the keys if you have used the Alt “i” key combination.  You are now on 

the “Save in” combo box.  Tap the down arrow key one time and a list drops down that 

shows all of the drives on your computer, including any USB memory devices that you 

have attached.  You are by default on the “My Documents” item.  Down arrow to the 

drive you want to save your file on.  If the hard drive is where you have created the 

folder where you want to save this file, down arrow to “Local Drive C.” 

 

  



Tap the Enter Key one time.  Tap the Tab Key three times and you will be in the folders 

for the drive you selected. 

 

  



Down arrow to the folder you want to save your file in.  Tap the Enter key one time and 

you will be in that folder. 

 

If there are sub folders in the folder you selected, you can down arrow to the sub folder 

you want.  If you are in the folder where you want to save the file, press and hold down 

the Alt Key and tap the letter “s” one time.  If you like to Tab, you can tap the Tab Key 

until you hear the “Save” button and then tap the spacebar one time.  The file will be 

saved and you will be placed back in your Notepad document.  The next time you press 

the Control “s” key combination you will not see the “Save As” dialogue box.  The file 

will simply be saved with the new text you have written. 

  



Saving a Notepad File in Windows 7 Using the “Save As” Dialogue Box 

Let’s say you have opened Notepad from the Accessories menu, the Windows 

command line, or by tapping the Windows Key one time, typing “Notepad,” using your 

down arrow key to go to the “Notepad” menu item, and then tapping the Enter Key one 

time.  You type the text you want and now are ready to save.  You press the Control “s” 

key combination and the “Save As” dialogue box comes up.   

  



You are in the “File name” edit box (form field).  You type a name for the file.  If you 

press the Enter Key the document you are saving will by default be placed in the 

“Document” folder.  This is fine if you only have a few files.  If you have a lot of files, say 

one hundred or more, it will be difficult to find this file the next time you want to open it.  

Unlike the Windows XP “Save As” dialogue box, you cannot press the Alt “i” key 

combination.  To get to the area of the “Save As” dialogue box where the drives on your 

computer are listed, you are going to have to do one of two things.  1.  Press and hold 

down the Shift Key and tap the Tab Key five times, or 2. Tap the Tab Key nine times.  

You want to hear or see the “Documents” item. 

 

  



Down arrow to the drive you want.  We will say that you are saving your file on the hard 

drive of your computer, so down arrow to “Local Drive C.”  Tap the right arrow one time 

to open this drive, down arrow to the folder you want, or tap the first letter of the name 

of the folder you want, and tap the Enter Key one time when you land on it. 

 

Tap the Tab Key one time to go into this folder.  Either tab to the “Save” button and tap 

the spacebar one time, or press the Alt “s” key combination.  The file will be saved on 

the drive, in the folder you have selected. 

  



Notepad “Word Wrap” 

Notepad does not “word wrap.”  If you type a long paragraph it will remain in a straight 

line across the screen.  This is a good thing if you are writing a computer program.  It is 

not so good if you are writing a letter you want to print. 

Screenshot of Notepad with “Word Wrap” Turned Off 

 

Screenshot of Notepad with “Word Wrap Turned On 

 

  



To turn on “Word Wrap” press and hold down the Alt Key and tap the letter “o” one time.  

Release these keys.  You will be placed in the “Format” menu directly over the “Word 

Wrap” menu item.  Tap the Enter Key one time to turn on word wrap.  If you need to turn 

word wrap back off, press Alt “o” and tap the Enter Key one time. 

 

If you are using a screenreader and “Word Wrap” is turned off you will notice that 

sentences are cut off unexpectedly.  If “Word Wrap” is turned on you will hear all of the 

text with no unexpected skipping of the text. 

If you want to print the document in Notepad or any other word processor, press 

and hold down the Control Key and tap the letter “p” one time.  Release these 

keys.  Tap the Enter Key one time and your document will print (provided you 

have attached a printer to your computer). 

  



WordPad (Windows XP) 

WordPad is found in the Windows “Accessories” menu.  It can be opened there, or by 

pressing and holding down the Windows (Start) Key and tapping the letter “r.”  Release 

these keys and the Windows command line appears.  Type “wordpad” (without the 

quotes).  Tap the enter key one time and WordPad will open.  In Windows Vista and 

Windows 7 you can tap the Windows (Start) Key one time, type “wordpad” (without the 

quotes), and then down arrow to the “WordPad” menu item.  At that point, tap the Enter 

Key one time and WordPad will open.  If you have installed Microsoft Word, or any other 

word processor, you will not be able to open WordPad in the Windows File Explorer.   

You can center, right align, left align and double space in WordPad.  Font type and color 

can be changed, as can the size of the font.  Following is a small list of universal key 

commands for formatting in WordPad. 

Control e means center 

Control r means right align 

Control l means left align 

Control 2 means double space 

Control 1 means single space 

Control b turns on bold and pressed a second time turns off bold 

Control I turns on italics and pressed a second time turns off italics 

Control u turns on underline and pressed a second time turns off underline 

  



Setting up fonts in WordPad is possible by going to the “Format” menu.  Press and hold 

down the Alt Key and tap the letter “o” one time.  Release these keys and you will be 

over the menu item called “Font.”   

 

Tap the Enter Key one time and you will be in the Font dialogue box. 

 

  



You are place in a combo box that allows you to type the beginning of the name of the 

font you want to use, and then down arrow until you hear it.  After hearing the font, tab 

one time and you will be in a combo box where you can down arrow to select items 

such as “Regular, Italic, Bold, or Bold Italic.”  We just covered the key commands for 

this above, and it may be quicker to use a Control “b” key combination that to open the 

Font dialogue box.  Tab again and you will be in the “Size” combo box.  You can either 

type in the size of the font (usually 12) for reports and research papers, or essays.  The 

font size can be made very large or very small.  Tab again and you will be in the 

“Effects” area, and over the first of two checkboxes.  The first checkbox is “Strikeout,” 

and the second checkbox is “Underline.”  You can tap the spacebar on either of these to 

check the box.  Tab again and you will be on the “Color” combo box.  Press and hold 

down the Alt Key and tap the down arrow key one time.  Release these keys and a drop 

down list of colors will appear.  Down arrow to the color you want and tap the Enter Key 

one time.  When you type again, your text will be in the color you selected. 

 

 

  



There are times when you need to make a bulleted list.  This might be for a grocery list, 

a list of topics to cover in a meeting, or items to study for before a text.  Press the Alt “o” 

key combination to go to the “Format” menu.  Down arrow one time to “Bullet Style” and 

then tap the Enter Key one time.  Type a word, tap Enter one time, type another word, 

and tap Enter one time.  You have just created a simple bulleted list.  To leave the bullet 

list setting, tap the Enter Key two times after the last item on your list. 

 

  



You can change the indentation of a paragraph on both the left and right side by press 

the Alt “o” key combination, down arrowing to “Paragraph” and tapping the Enter Key 

one time.  A dialogue box will come up with three edit boxes (form fields), one combo 

box, and two buttons.  The edit boxes are “Left, Right, and First Line.”  The combo box 

starts with “Left, then Right, and finally Center.”  The first button is the button is “OK,” 

and the second button is “Cancel.”  Before you change the paragraph alignment, write 

down the original settings.  You will need in many cases to return to these settings at a 

later time.  Visually an indented paragraph looks like an inset, single spaced paragraph 

in the middle of a standard documented, even a double spaced document. 

 

  



If you want to insert a picture into a WordPad document, press the Alt “i” key 

combination.  Release these keys.  Down arrow one time to “Object,” and tap the Enter 

Key one time.  A dialogue box will come up with a list of files you can create.  Press and 

hold down the Shift Key and tap the Tab Key one time.  You are now on the “Create 

New” radio button.  Down arrow one time and you will be on the “Create From File” 

radio button.  Press Alt “b” to browse your computer.  You will, by default, be placed in a 

“Browse” dialogue box, in the “My Documents” folder.  Press Alt “i” and then down arrow 

to the drive you want.  Tab three times, and then down arrow to the folder you want.  

Down arrow to the file (probably a picture) you want to insert into the WordPad 

document. 

 

  



Tap the Enter Key one time and a link to the picture will be inserted into your document, 

where the cursor is located. 

 

There is no spell checker for WordPad.  You can go onto the internet and search for 

WordPad spell checkers that you can “download” into your computer.  



Saving a WordPad document is the same as saving a Notepad document, with one 

difference.  When you press Control “s” for the first time in the document, and the “Save 

As” dialogue box comes up, type the name you want for your file, and then tap the Tab 

Key one time.  Down arrow one time and you will be on the first of four choices.  This 

first choice is “Rich Text Format.”  If you want to keep the formatting and font colors of 

your document, this is the choice you want.  Simply tab on.  If you want just text, down 

arrow to one of the other three choices, and then tap the Tab Key. 

  



WordPad (Windows 7) 

WordPad in Windows 7 operates with the “ribbon.”  You cannot use Alt “o” for the 

“Format” menu, nor Alt “i” for the “Insert” menu.  Visually, the “ribbon” goes from the left 

to the right, across the top of the document.  It looks like a ribbon that you might find on 

a package, or an award ribbon turned sideways.  On this “ribbon” are items that set up 

fonts, line positioning, inserting, and many other things.  The best way to approach this 

“ribbon” is to tap the Alt Key one time.  Next, tap the Tab Key until you hear or see 

the item you want, and then tap the Enter Key one time to open that item.  You 

can go backward through the “ribbon” by pressing and holding down the Shift 

Key and repeatedly tapping the Tab Key.  Also, your bold, italic, underline, center, 

right and left align key commands still work in this version of WordPad.  You save your 

file in the same way you did in Notepad for Windows 7. 

 

  



Calculator 

You can open the “Calculator” from the Accessories menu.  You will not be able to open 

the Calculator from the Windows Key “r” command line.  In Windows 7 you can tap the 

Windows (Start) Key one time, type “calculator” (without the quotes), down arrow to the 

“Calculator” item, and then tap the Enter Key one time to open it. 

 

Once the Calculator has started you can use you numeric keypad to write basic math 

problems and tap the Enter Key to calculate the answers.  There are many things you 

can do with the Calculator, and a number of different modes you can put it in.  Following 

is a list of the main four modes that you can place the Calculator in. 

Alt 1 is Standard mode 

Alt 2 is Scientific mode 

Alt 3 is Programmer mode 

Alt 4 is Statistics mode 

  



The face of the Calculator is graphical; therefore Microsoft has created a long list of key 

commands.  The following list is copied directly from the “Help” section for the 

Calculator, and is exclusively owned by the Microsoft Corporation. 

The following table contains keyboard shortcuts for working with Calculator, and is 

taken directly from Microsoft material. 

Press this key To do this 

Atl+1 Switch to Standard mode 

Alt+2 Switch to Scientific mode 

Alt+3 Switch to Programmer mode 

Alt+4 Switch to Statistics mode 

Ctrl+E Open date calculations 

Ctrl+H Turn calculation history on or off 

Ctrl+U Open unit conversion 

Alt+C Calculate or solve date calculations and worksheets 

F1 Open Calculator Help 

Ctrl+Q Press the M- button 

Ctrl+P Press the M+ button 

Ctrl+M Press the MS button 

Ctrl+R Press the MR button 

Ctrl+L Press the MC button 

% Press the % button 

F9 Press the +/– button 

/ Press the / button 

* Press the * button 

+ Press the + button 

- Press the – button 

R Press the 1/× button 

@ Press the square root button 

0-9 Press the number buttons (0-9) 

= Press the = button  

. Press the . (decimal point) button 

Backspace Press the backspace button 

Esc Press the C button 

Del Press the CE button 

Ctrl+Shift+D Clear the calculation history 

F2 Edit the calculation history 

Up Arrow key Navigate up in the calculation history 



Press this key To do this 

Down Arrow key Navigate down in the calculation history 

Esc Cancel editing the calculation history 

Enter Recalculate the calculation history after editing 

F3 Select Degrees in Scientific mode 

F4 Select Radians in Scientific mode 

F5 Select Grads in Scientific mode 

I Press the Inv button in Scientific mode 

D Press the Mod button in Scientific mode 

Ctrl+S Press the sinh button in Scientific mode 

Ctrl+O Press the cosh button in Scientific mode 

Ctrl+T Press the tanh button in Scientific mode 

( Press the ( button in Scientific mode 

) Press the ) button in Scientific mode 

N Press the ln button in Scientific mode 

; Press the Int button in Scientific mode 

S Press the sin button in Scientific mode 

O Press the cos button in Scientific mode 

T Press the tan button in Scientific mode 

M Press the dms button in Scientific mode 

P Press the pi button in Scientific mode 

V Press the F-E button in Scientific mode 

X Press the Exp button in Scientific mode 

Q Press the x^2 button in Scientific mode 

Y Press the x^y button in Scientific mode 

# Press the x^3 button in Scientific mode 

L Press the log button in Scientific mode 

! Press the n! button in Scientific mode 

Ctrl+Y Press the y√x button in Scientific mode 

Ctrl+B Press the 3√x button in Scientific mode 

Ctrl+G Press the 10x button in Scientific mode 

F5 Select Hex in Programmer mode 

F6 Select Dec in Programmer mode 

F7 Select Oct in Programmer mode 

F8 Select Bin in Programmer mode 

F12 Select Qword in Programmer mode 

F2 Select Dword in Programmer mode 

F3 Select Word in Programmer mode 



Press this key To do this 

F4 Select Byte in Programmer mode 

K Press the RoR button in Programmer mode 

J Press the RoL button in Programmer mode 

< Press the Lsh button in Programmer mode 

> Press the Rsh button in Programmer mode 

% Press the Mod button in Programmer mode 

( Press the ( button in Programmer mode 

) Press the ) button in Programmer mode 

| Press the Or button in Programmer mode 

^ Press the Xor button in Programmer mode 

~ Press the Not button in Programmer mode 

& Press the And button in Programmer mode 

A-F Press the A-F buttons in Programmer mode 

Spacebar Toggles the bit value in Programmer mode 

A Press the Average button in Statistics mode 

Ctrl+A Press the Average Sq button in Statistics mode 

S Press the Sum button in Statistics mode 

Ctrl+S Press the Sum Sq button in Statistics mode 

T Press the S.D. button in Statistics mode 

Ctrl+T Press the Inv S.D. button in Statistics mode 

D Press the CAD button in Statistics mode 

 

  



Chapter 18 Review 

Test Your Knowledge 

1.  Name the word processor programmers might use to write computer programs. 

2. Name the three Font changes that can be done using a combination of the 

Control key and a letter key. 

3. Name the three line position for text key commands that utilize the Control Key 

and a letter key. 

4. Name the item in WordPad for Windows 7 that gives you access to fonts, colors, 

and other items. 

5. Name the program in Windows that allows you to do math. 

 


